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About this manual
Read “rekordbox Introduction” and “Instruction Manual.”

• In this manual, the name of buttons and menus displayed on rekordbox are 
indicated with brackets (e.g. [BPM], [Collection] window).

• Please note that depending on the operating system version, operation of web 
browser settings, etc. may differ from the procedures described in this manual.

• Please note that the language on the rekordbox screen described in this manual 
may differ from the language on your screen.

• Please note that the specifications, design, etc. of rekordbox may be modified 
without notice and may differ from the descriptions in this manual.



3

Contents

About this manual .................................................................................................................................................. 2

Introduction................................................................................................................................. 4

About the EDIT mode screen..................................................................................................... 5

Editing.......................................................................................................................................... 8

Selecting a track for editing.................................................................................................................................... 8

Selecting the range for editing ............................................................................................................................... 9

Saving the edited contents as a project ............................................................................................................... 14

Render the edited track as an audio file............................................................................................................... 15

Others ........................................................................................................................................ 16

Menu list............................................................................................................................................................... 16

Troubleshooting ................................................................................................................................................... 16

System Requirements.......................................................................................................................................... 17

Copyright warning ................................................................................................................................................ 17

Trademarks and licenses ..................................................................................................................................... 17



4

Introduction

On EDIT mode, you can edit tracks in advance to make your DJ performance easier. 
You can easily change the track composition such as extending intro/outro, copying/
deleting the interlude.
Depending on your subscription plan, some functions may not be available. For 
details on subscription plan, refer to the rekordbox website.
rekordbox.com/en/

: Invalid function on your subscription plan

If you have used an earlier rekordbox version than ver. 6.1.0, EDIT mode is not 
available. Please update rekordbox to the latest version (ver. 6.1.1 or above).

On Edit mode, following contents cannot be edited.

• Video files

• Streaming tracks

https:///www.rekordbox.com/en/


About the EDIT mode screen

Check that [EDIT] is selected in the upper-left corner of the screen.

1. Project name

2. Select [EDIT] mode.

3. Create a new project.

The current project will be closed, and the screen will be cleared.

4. Save a project (page 14).

5. Render audio files (page 15).

6. Move the playback position to the beginning of the timeline.

7. Start or pause playback.

8. Turn on/off loop playback.

When you start playback in Loop:ON (in orage), the selected range plays in loop.

9. Quantize

Specify the minimum unit (1 beat/4 beats) to select the range.

10. Track information panel (page 7)
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About the EDIT mode screen
11. Bar number

You can change the position of the enlarged waveform to be displayed by 
dragging to the right/left.

12. Enlarged waveform

Click to specify the range.

13. Change a zoom ratio of the enlarged waveform.

: Hide the icons.
[RST]: Reset the zoom ratio.

14. Display the browser panel (page 8).

15. Action pad [BEAT SELECT] panel (page 9)/[SELECT] panel (page 10)

16. Action pad [EDIT] panel (page 11)

17. Action pad [PALETTE] panel (page 12)
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About the EDIT mode screen
• Following tracks cannot be loaded to the deck of EDIT mode.

– Unimported tracks
– Unanalyzed tracks
– Tracks in the [Devices] category

• Active Censor marks, phrases, and vocal information cannot be displayed on the 
deck of EDIT mode.

1. The track’s artwork image is displayed.

Point on the artwork image with the mouse cursor to display , and then click 
 to unload the track.

2. Track name

3. Selected range

4. Time and measure at the pointed position with the mouse cursor

5. Track time

6. Key

7. BPM

Note

• When you load a track, BPM is constantly adjusted. For tracks analyzed with [Dynamic] or 
adjusted partially with grid spacing in the [GRID] panel, some part of track will have a different 
sound or BPM than its original.

Track information panel

1 2 3 4 5 6 7
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Editing

After loading a track in [Collection] to the deck, you can duplicate, copy cut, delete, 
mute, etc. a specified range of waveform within the track.
The edited contents are not applied to the track in [Collection]. To use the edited 
contents for your DJ play, render the edited track as an audio file ( ), and then 
add the audio file to [Collection].
Also, you can edit again after saving the edited contents as a project.

Selecting a track for editing

1 Click the [BROWSER] tab to open the browser panel.

2 Select a tack from [Collection].
Double-click a track you want to edit.
• Information about Grid, Hot Cue, Memory Cue, and Active Censor are also 

loaded, but these information cannot be edited.
• Information about phrases and vocal are not loaded.
• A track edited in EDIT mode is displayed with [ ].

3 Click the [BROWSER] tab again to close the browser panel.
8



Editing
Selecting the range for editing
To select the range, drag on the enlarged waveform. Or, select the starting point, 
and then click the ending point with holding the Shift key. The bar length, beat 
length, and time of the selected range will be displayed.

You can specify the range with beats of number from the selected position.

Specifying the range using the [BEAT SELECT] 
panel
9



Editing
You can double or halve the length of the selected range.

1. Halve the length of the selected range.

2. Double the length of the selected range.

3. Cancel the selected range.

Changing the length of the selected range 
using the [SELECT] panel

21 3
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Editing
You can edit using the selected range.

1. Copy the selected range, and then insert after it.

2. Copy the selected range.

3. Paste the copied selected range.

4. Insert the copied selected range.

5. Delete the selected range from the track.

6. Mute the selected range.

7. Return to the previous state.

8. Return to the state before [UNDO].

Hint

• You can edit by selecting an item from the [Edit] menu in the upper-left corner of the screen or 
from the menu of right-clicking.

Editing a track using the [EDIT] panel

65 7 8

21 3 4
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Editing
Drag and drop the selected range to the [PALETTE] panel to keep it (up to 100 
ranges for a track).

1. Hide the [PALLETE] panel. Click again to show the panel.

2. Change the screen to delete the kept range.

Click the delete button of each range.

3. Name the title for the kept range.

4. Play/pause the kept range.

You can also play the kept range by clicking the waveform.

Keeping the selected range in the [PALETTE] 
panel
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Editing
5. Keep the selected range in the [PALETTE] panel.

Drag the waveform in the [PALETTE] panel, and drop it to the point where you want 
to insert in the enlarged waveform.

Hint

• You can also select [Insert] from the [EDIT] menu in the upper-left corner of the screen.
• You can also select [Insert] by right-clicking the point where you want to insert in the enlarged 

waveform.

Inserting the selected range from the 
[PALETTE] panel
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Editing
Saving the edited contents as a project
If you save the edited contents as a project, you can select the project to edit from 
the continuation.

1 Click  in the upper-left corner of the screen.
For the first time to save, the folder where the project is saved opens. Enter the 
project name, and then the edited contents are saved as a project.
If these contents have already saved as a project, it is overwritten.

Hint

• You can also select [Save] from the [File] menu in the upper-left corner of the screen. To save 
with a different name from the already saved project, select [Save as].

• Project file is not supported with followings:
– Cloud Library Sync
– Library Backup

• When the track is loaded, a message to save the editing appears when you load the other track.

Click the project in the upper-left corner of the screen to display the recent project 
list. Projects are displayed in the new order not according to the folders including 
projects.
When you select the project, the track is automatically loaded to the deck, and then 
you can edit.

Hint

• When you select [Open a recently edited project] from the [File] menu in the upper-left corner of 
the screen, projects used recently are displayed in the list. Select [Open project] to open the 
folder where you saved the project at the last.

• The list for the recently used projects are displayed with up to 20 projects.

Note

• You cannot open the project of the track deleted from [Collection].

Open the saved edited contents (project)
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Editing
Render the edited track as an audio file
For DJ play the track included with edited contents, render the track as an audio file 
to add to [Collection], Hot Cue, Memory Cue, grid information, Active Censor, etc. 
can be exported from the original track to render. However, analysis information of 
phrases and vocal cannot be exported. Please analyze again.

Note

• If you have signed up the Creative plan, rendering can be used.

1 Click  in the upper-left corner of the screen.
The [Render Audio] window appears.

2 Enter the track name and artist name, and select the location to be saved, file 
format, and sample rate/bitrate.

3 Click [Render].
Rendering an audio file starts.
Rendered audio file will be automatically added to [Collection].

Hint

• You can also select [Render audio files] from the [File] menu in the upper-left corner of the 
screen.

Note

• The track with 180 minutes or more cannot be rendered.
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Others

Menu list
Depending on your rekordbox version and subscription plan, some items may not 
be displayed.
Read “Instruction Manual” on the rekordbox website.

| [File] menu

• [Open a recently edited project]

• [Open project]

• [Save]

• [Save as]

• [Render audio files]

| [Edit] menu

• [Select the range]

• [Add to palette]

• [Clone]

• [Copy]

• [Cut]

• [Paste]

• [Insert]

• [Delete]

• [Clear]

• [Undo]

• [Redo]

Troubleshooting
Before making inquiries on operating procedures or technical issues, check the FAQ 
provided on rekordbox.com.
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Others
System Requirements
For the latest information (compatible OS, system requirements, etc.) on rekordbox, 
refer to rekordbox.com.

Copyright warning
The use of rekordbox is restricted with regard to the playing and copying of copy-
protected music.

• The program may not operate properly if copy-protect encryption data is 
embedded in recorded media.

• Playback, analysis, and other operations may stop if copy-protect encryption data 
is detected as embedded in recorded media.
The material you record is for your own listening enjoyment, and cannot be used 
for other purposes without permission from the copyright owner.

• Music recorded from CDs and other media may be protected by the copyright laws 
of individual countries as well as by international convention. You are solely 
responsible for the lawful use of the recordings you make.

• When handling music that has been downloaded over the internet, the person who 
has downloaded the music is fully responsible for using the music in compliance 
with his/her contract with the site from which the music was downloaded and the 
copyright laws of individual countries as well as by international convention.

Trademarks and licenses
• rekordbox™ is a trademark or registered trademark of AlphaTheta Corporation.

• Other product, technology and company names, etc. mentioned herein are 
trademarks or registered trademarks of their respective owners.

©2020 AlphaTheta Corporation. All rights reserved.
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